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History of Changes
Version

Description of Change

Authored by

Date

1.1

Extend the policy and procedure
to include external and systems
verification.
Amended the terminology for
assessments using the SQA
assessment guidelines that
assessments must be valid,
reliable, practicable, fair and
equitable.
Included in the related
documents section the
Revalidation Approval Form and
Standards Verifier Report.
Correction of minor typing errors.
Clarifying the role of the
programme leader in the
operation of this policy
To ensure compliance with the
actions and recommendation
from the SQA systems
verification visit.
To provide further guidance on in
programme sampling from City &
Guilds.
To provide guidance on the use
of marked exemplars from
Pearson

D. Killean
C. Elliott

22/5/15

1.2

Clarification of IV responsibility
for checking assessment using
digital media as the delivery
method for the assessment
instrument

D Killean

22/5/17

1.3

Updating roles and
responsibilities. Separating
Policy from Procedure.
Reorganisation of content.
Guidelines on security of
assessments

C Elliott
J Robertson

22/08/18
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1.4

Further updates and clarification
of roles. IV Security Process
included as an appendix

J Robertson

20/11/18

1.4.1

Inclusion of information from
BCS at request of EV

J Robertson

15/04/19

1.4.2

Standardisation Agenda revised
to include Exam Boards for
Graded Units

J Gracie

20/10/20

1.5

Revision of roles and hyperlinks

J Gracie

March 2021

1.6

Revision following recommendations J Gracie
from IV Audit
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Internal and External Verification Procedure
1. Purpose
Internal Verification is designed to ensure that staff within the centre are making
consistent and accurate assessment decisions in accordance with the assessment
criteria set by External Awarding Bodies.

2. Scope
This procedure is to be implemented at all Borders College campuses, work-based
sites, and other locations where assessments may take place.

3. References
•
•
•
•
•
•
•

Borders College Internal and External Verification Policy
Borders College Quality Enhancement Handbook
Borders College Assessment Policy
Borders College Malpractice Policy
Borders College Assessment Arrangements Policy & Procedures
Borders College Approval Procedure
Borders College IV Security Process

4. Definitions
SQA definitions of terminology used in this procedure are contained in Appendix 1.

5. Internal Verification Procedure
5.1 The College must be able to demonstrate that it has an effective procedure in
place to ensure that all assessments are well-designed, consistent, and
accurate and meet national standards. To achieve effective standardisation
across all programmes of study it is essential that all members of staff are
committed to the quality system at all stages, from course approval to Awarding
Body certification.
5.2 Assessors must be occupationally competent in assessment and quality
procedures before they are appointed as an Internal Verifier.
5.3 In cases where there is only one Assessor in any specialist subject, verification
arrangements may need to be made with an External Agency. It is the
responsibility of the Assistant Principal (AP) to ensure a formalised agreement
or contract with an external party is implemented. Internal Verifiers and
Assessors may be required to carry out verification and/or assessment within
the College and/or out with the College environment.
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5.4 Appendices contain the following information:
Appendix 1 – glossary of definitions
Appendix 2 – flowchart of the Pre-delivery Process
Appendix 3 – electronic storage of assessments and documentation
Appendix 4 – flowchart of the Sampling Process
Appendix 5 – criterion for Not Accepted decision or Sanction
Appendix 6 – Standardisation Activities
Appendix 7 – links to Internal Verification documents
Appendix 8 – roles of staff involved in the IV/EV process
Appendix 9 – IV security process
NOTE: Where CLMs are identified in these procedures, this also applies to the DEBI
Manager.

Pre-Delivery (Appendix 2, Pre-delivery Flowchart)
5.5 Curriculum Learner Managers (CLMs) allocate appropriate occupationally
competent Internal Verifiers (IVs) to internally verify units. This information
should be recorded on the Course Structure ProSolution application. The IV
Sampling Plan (IV13) should reflect the exact same information and be
accurately maintained by the CLM on an ongoing basis. Where a unit is
delivered in more than one portfolio area, the CLMs will agree how this will be
managed. It is important that CLMs liaise with the Quality Assurance CoOrdinator (QAC) to ensure that all assessments held in the shared portfolio
area are still current for delivery. The IV Sampling Plan should reflect this.
5.6 The CLM holds a Standardisation/Cognate Group meeting at the start of each
teaching block (August and January of each academic year) with their IVs and
Assessors. This should focus on pre-delivery and population of the IV13.
An Assessment Schedule for each course must be created and updated to
reflect timetables. Information on the assessor and IV should also be included
on the assessment schedule. This should be stored in the shared portfolio area.
(Appendix 3 – IV folder for electronic materials.)
A cross-college IV Sampling Plan must also be completed for all Core Skills
units.
5.7 The Assessor sends a Notification of Delivery form (NOD) (IV1) to IVs for
subjects they are delivering. The Assessor is required to:
•
•
•

identify the current assessment they hold, or
request the assessment, or
provide a new/amended assessment to be internally verified.

5.8 IVs check against the IV13 to ensure the most recent assessment is being used
or will internally verify new/amended assessments. The IV updates the NOD
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and issues completed NOD and internally verified assessments as requested to
the Assessor. The IV updates the IV13 and saves new/amended assessments
in the shared portfolio area. Delivery commences.
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5.9 Awarding Bodies may provide exemplar materials to support delivery. In these
cases, Internal Verification should be carried out by the College to check
accuracy and adequacy of such materials using the IV Feedback Form for New
or Amended Assessments (IV2).
Any materials developed by College staff require Internal Verification and it is
recommended that materials are submitted for Prior Verification to the Awarding
Body. Staff seeking this approval must do so through the QAC.

Sampling (Appendix 4, Internal Verification Sampling Flowchart)
5.10 The level of sampling used in the Internal Verification process must be
comprehensive enough to ensure assessment decisions are fair, equitable,
reliable, and consistent. Each unit is primarily subject to a 3-year sampling
cycle; however, the sampling must also be carried out in response to the
following factors:
•
•
•
•
•
•
•
•

the unit is being delivered for the first time
the unit has undergone major revision
the Assessor is new to assessing
the Assessor is delivering a unit for the first time
the unit is an HN graded unit
an EV visit is scheduled for the unit
the unit was previously subject to sanctions by the Awarding Body
sanctions identified through Internal Verification in the previous year.

5.11 The IV must check Assessment Schedules prior to issuing a Sampling Request
Form (IV4). Unless otherwise stated, the sample should be 10% of the group or
3 candidates, whatever is the highest.
On receipt of the IV4, it is the Assessor’s responsibility to provide the following
materials for verification within the agreed timescale and prior to the date given
as a deadline for verification activities:
•
•
•
•
•

Unit Specification
instruments of assessments
completed Assessor marked assessments to date
Candidate feedback forms
marking guidelines/exemplar answers.

5.12 Where the Assessor has not provided materials requested for Internal
Verification within the agreed timescale, the IV will, in the first instance, make
contact with the Assessor to ascertain the reason. The CLM must be kept
informed.
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In certain circumstances it may be required to agree a new submission date. If a
new submission date is agreed the CLM must be informed and the IV13 and
Assessment Schedule updated.
If the materials are not received by the revised date, and no reasonable reason
is provided by the Assessor, then the IV, in consultation with the CLM, must
complete the Internal Verification – Sampling Feedback Form (IV5) and place a
‘Not Accepted’ (Hold) decision on the unit. A copy must be sent to all staff on
the circulation list on the form.
The ‘Not Accepted’ decision will be monitored on a weekly basis by the CLM
until such times as the materials have been successfully internally verified and
the ‘Not Accepted’ decision lifted.
5.13 Following verification of materials, the IV will complete the IV - Sampling
Feedback Form (IV5), including feedback on any areas of good practice and
any areas for improvement. If the IV is satisfied that the required competencies
have been met, an ‘Accepted’ decision is indicated. The IV saves the completed
IV5 on the shared portfolio area and sends a copy to the Assessor. The IV
updates the IV13 with the sample outcome.
5.14 Should the IV find inconsistencies in the assessment process a ‘Not Accepted’
decision should be indicated on the IV5 including clear feedback provided on
areas for improvement. A date should be agreed with the Assessor for resubmission.
Criteria for placing an internal ‘Not Accepted’ or an internal ‘Sanction’ on
qualifications are detailed in Appendix 5.
5.15 If no agreement can be reached or difficulties are not resolved, this must be
indicated on the IV5 and referred to the CLM. A meeting is then arranged with
the Assessor, IV and CLM to agree appropriate action.
5.16 When agreement is reached between the IV and Assessor and the appropriate
action taken to resolve a ‘Not Accepted’ decision, the materials are subject to
further verification and the IV5 must indicate this with the words ‘Not Accepted
Lifted’. The IV saves a copy of this on the shared portfolio area and sends a
copy to the Assessor and CLM. The IV updates IV13 to indicate that sampling
has taken place and the sample outcome.
5.17 The CLM is responsible for Internal Verification activity within their assigned
area of responsibility.
NOTE: Assessors and IVs must ensure the secure transportation of assessment
materials within the College and/or out with the College environment in accordance
with General Data Protection Requirements.
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Standardisation Activities (as described in Appendix 6)
5.19 The CLM will Chair Standardisation/Cognate Group meetings and circulate
actions. The meetings will take place in August and January of each
academic session and will include all relevant Assessors and IVs.
Standard Agenda for Standardisation/Cognate Group meetings:
1
2
3
4
5
6
7
8
9
10
11
12
13
14

15
16

Minutes of previous meeting
Matters arising
Feedback from External Verification and/or Internal Audit and resultant
actions, development points and recommendations
Update on changes to Group Awards and units on the Course
Structure ProSolution application and impact on Assessor and IV
allocation on IV13.
Confirm course Assessment Schedules with Assessor and IV
allocations.
Feedback from IV on sampling and standardisation activities
Standardisation activity (if appropriate)
Exam Board (graded units) activity to be confirmed for academic session.
Achievement Board (Group Awards and individual unit) activity to be confirmed for
academic session.
Assessment issues, including, instruments of assessment, assessment
environment, sampling of assessments
Sufficiency of facilities, equipment and learning materials and assessment
and internal verification document security
Security of Assessments and Internal Verifier documentation
Student Appeals
Any Issues relating to:
•
Sustainability
•
Health & Safety
•
Equalities and Diversity
•
GDPR
Any other business
Date of next meeting

6. Registers
It is the Assessor’s responsibility to update their assessment registers. On campus
activity relating to the completion of assessment registers by assessors requires a
high level of accuracy and checks against the Course Structure ProSolution
application is advised. Remote and online completion of assessment register also
requires a high degree of accuracy and staff are advised to agree screen sharing
with the Course Tutor or CLM. Any inaccurate entries may be considered under the
Malpractice Policy and all near misses will be recorded by the MIS team and
reported to the Head of MIS..
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The MIS team update assessment registers on an ongoing basis and generate
reports for SLT. Unit Deferral forms should be completed in agreement with the CLM
and used only in exceptional circumstances for extending the completion of a
register.

7. Internal Audit (IV11)
The audit team will carry out sampling of assessment material throughout the year.
The audits will cover specialist subject areas and assessment registers and will be
conducted annually unless circumstances require additional audits.
The Internal Verification audit’s scope is detailed in IV11.
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8. Security of Assessments and Associated
Documentation to Support the IV Process
Misuse or breach of the IV process will be considered under the College’s
Malpractice Policy.

9. External Verification and Systems Verification
Each Awarding Body has their own External Verification system. For further details of
their requirements refer to the Quality section of the College Intranet or contact the
QAC.
9.1 External Verification Visits
If EV activity is requested, this is managed by the CLM.

Prior to External Verification
a)

The EV will request a timeframe for a visit or an EV event which will be confirmed to the
QAC.

b)

The date of the visit or event will be agreed by the CLM after discussion
with affected staff and notified to the QAC.

c)

This date will be confirmed to the Awarding Body/External or Qualification
Verifier by the QAC.

d)

An External Verification Visit Plan is received from the EV. The QAC will inform
the CLM who will co-ordinate with their team.

e)

Prior to the visit or event, the Lead IV will arrange the gathering of materials
relating to the units/awards in the Verification Group in line with the
requested sample.

During External Verification Activity
f)

The CLM will lead the co-ordination of the visit or event, and ensure that Lead
IV, IVs, Assessors and Candidates are available for any points of clarification.
Access to electronically held data will be made available to the EV during a visit
or event.

After External Verification Activity
g)

The QAC will forward a copy of any external feedback to the AP and CLM for
distribution to relevant staff, retaining the original in the College’s central file.
Where an External ‘Not Accepted’ is placed on results and certification, the
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QAC will inform the Assistant Principal Quality and Development and the Head
of MIS.

Regionally Focused – Globally Engaged

Uncontrolled Copy

12

Internal and External Verification Procedure
h)

The AP has overall responsibility for organising any materials or information
required to lift any ‘Not Accepted’ sanctions put on results/certification and will
send these to the QAC who will forward these to the Awarding Body.

i)

In the Event of a ‘Not Accepted’ being lifted, the QAC will send a copy of the
revised report to the VP, AP, CLM and will also notify Head of MIS. The CLM
will address any issues arising at the next Standardisation/Cognate Group
meeting.

9.2 Central Verification – Postal/Visit
Where the College has been selected for Central Verification the Awarding Body will
require the Candidates’ marked assessed work to be submitted to them for
verification.
a)

The Awarding Body will notify the QAC of the date of pick-up of the material.

b)

The QAC will notify the CLM of the date and agree a date for submission.

c)

The Lead IV will collate the assessed material and records of Internal
Verification and provide them to the QAC within the agreed Awarding Body
timeframe.

After Central/Postal External Verification:
d)

The QAC will forward a copy of any external feedback to the appropriate AP
and CLM for distribution to relevant staff, retaining the original in the College’s
central file. Where an External ‘Not Accepted’ is placed on results and
certification, the QAC will also inform the VP, AP, CLM and Head of MIS.

e)

The AP has responsibility for organising any materials or information required to
lift any ‘Not Accepted’ sanctions put on results/certification. This is to be sent to
the QAC who will forward it to the Awarding Body.

f)

The QAC will forward a copy of all subsequent Awarding Body correspondence
to the AP, CLM and Lead IV.

g)

In the event of a ‘Not Accepted’ being lifted, the QAC will send a copy of the
revised report to the VP, AP, CLM and notify the Head of MIS. The CLM will
address any issues arising at the next Standardisation/Cognate Group
meeting.

9.3 Monitoring External Verification Action Points
The QAC will ensure that all External Verification reports are distributed to the AP
and CLM.
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Where a report contains Action Points these should be addressed by the CLM and
the QAC kept informed of progress. All Actions Points should be achieved by the
required date to ensure that this does not impact on the risk profile of the College.
The QAC will report monthly to the Senior Leadership Team on progress made with
Action Points from all External Verification activity and will monitor progress until
actions are addressed.
9.4 Systems Verification
In addition to External Verification, Awarding Bodies will check the College’s
compliance with their Quality Assurance Systems criteria.
This involves the examination of the policies, procedures and management of the
qualifications delivered on behalf of the Awarding Body. Typically, Systems
Verification will involve a visit to the College by an Auditor appointed by the Awarding
Body.
Where the College is found to be non-compliant with criteria an Action Plan will be
required to address the discrepancy. If this is not achieved within the timescale the
risk level of the College will be heightened by the Awarding Body with the ultimate
sanction being the removal of the College’s ability to deliver their qualifications.
9.5 Qualifications Regulators
Qualifications delivered by Borders College are overseen by regulators. In Scotland it
is the responsibility of SQA Accreditation, for English qualifications it is Ofqual.
Both these organisations have a statutory responsibility for the quality and standards
of qualifications. The College will comply and co-operate with audits undertaken in
pursuit of their statutory duties.

10. Retention of Assessment and Verification Evidence and
Record Keeping
The College will retain Internal Verification records for 3 years following the date of
certification. For retention of Candidates’ assessment evidence, refer to relevant
Awarding Body guidelines.

11. Assessor Appeals
Grounds for Appeal are when the Assessor disagrees with the IV’s decision.
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Stages of Appeal
Stage 1
If an Assessor disagrees with the IV’s decision on any aspect of Internal
Verification, they should contact the IV to try to resolve the position. An informal
discussion should take place between the IV and the Assessor. If there is no
agreement, go to Stage 2.
Stage 2
If the Assessor remains dissatisfied with the IV’s decision they should, within 5
working days of receiving IV5, submit a written appeal to the IV.
The IV concerned must reply to the Assessor in writing within 5 working days of
receiving such an appeal.
A copy of the Assessor’s appeal and the IV’s reply must immediately be given to the
CLM.
Stage 3
If the Assessor wishes to further pursue the appeal, they should contact the AP.
The AP will consider the appeal and reply in writing within 5 working days. This is the
final stage of the appeals process.

Regionally Focused – Globally Engaged

Uncontrolled Copy

15

Internal and External Verification Procedure

Appendix 1

Glossary of Definitions
1

Internal Verification The process adopted to ensure that consistent and
accurate standards are being applied uniformly and
maintained in the assessment of work based SVQs and
NVQs.

2

Accepted

The College’s assessment approach and judgements are
fully in line with national standards.

3

Accepted

The College’s assessment approach and judgements are
in line with national standards but there are suggested
recommendations to improve.

4

Not Accepted

There are significant issues with the internal assessment
approach and/or judgements. Required Actions are
specified which must be completed. Certification can only
take place once these are resolved.

5

Verification Cannot
Proceed (VCP)

Insufficient or incorrect evidence have been
provided. Required Actions are specified which must be
completed before verification can proceed.

6

Sanction

A term used by an Awarding Body when an approved
centre’s management and quality assurance systems do
not fully comply with the quality assurance criteria. There
are different levels of sanctions that can be imposed,
depending on issues identified.

External Verifier reports from SQA (for HN, VQ and NC qualifications) will include a
‘traffic light’ rating for every criterion:
Green: Sufficient evidence – this means that the centre has provided evidence that
fully meets the criterion (i.e., there are no Required Action points).
Amber: Insufficient evidence – this means the centre can provide some evidence in
support of the criterion, but it is not sufficient (i.e., there are Required Action
points).
Red:

Little or no evidence – this means that evidence provided by the centre falls
well short of meeting the criterion (i.e., Required Action points will be set).
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Appendix 2

Pre-delivery Procedures (Flow Chart)
When a Current Assessment
Pack is to be used

When Assessment Pack
is new or amended

Assessor sends NOD (IV1) to
IV indicating whether they
hold a current pack or not
(identify assessment pack
version date on form in order
for the IV to check the
assessment being used )
IV checks NOD against IV13
and updates NOD
accordingly. Current
assessment sent to Assessor
(where necessary) with
completed NOD

Assessor sends New or
Amended Assessments
form (IV2) and new
assessment to IV
IV checks pack
against criteria of Unit Spec.
Does it meet criteria?

Yes

IV inserts IV footer into
assessment.
IV updates IV13 and sends
completed NOD and
assessment to IV

No

IV returns pack to
Assessor for
amendment and
re-submission

DELIVERY CAN COMMENCE

The assessment pack contains:
•
•
•
•

Standards/Unit Specification
Instruments of Assessment
Re-assessments (where appropriate)
Marking Scheme (if applicable)
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Appendix 3

IV Folder (Electronic)
The central portfolio storage area, managed by the CLM, will include:
•
•
•
•
•
•

Internally Verified master assessment packs
IV13
Assessment Schedules
Copies of EV Reports
Minutes of Standardisation/Cognate Group meetings from August and January of each
academic session
Detail of what platform used to assess the candidate e.g., VLE/Smart
Assessor

The following documents should be stored centrally as per the requirements of the
portfolio area:
•
•
•
•
•
•
•

Copies of Notification of Delivery Forms (IV1)
Internal Verification Feedback Forms for New or Amended Assessments (IV2)
Internal Verification Checklist (IV3)
Internal Verification Sampling Request Form (IV4)
Internal Verification Sampling Feedback Form (IV5) (VQ DEBI IV6)
VQ Final Verification on Completed Portfolio Form (VQ DEBI IV7)
IV Record of Assessor Monitoring (VQ DEBI IV8)
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Appendix 4

Internal Verification Sampling Flowchart
CLM meets with Course Team /Verification
Group in August and January of each academic session
and agree information on IV13.
sampling

Consider IV Sampling Plan (IV13) and agree
Minutes of meeting taken

IV sends out IV4 form (Sample Request)
Assessor provides materials for verification according to request within timescale specified
IVs internally verify assessed evidence using IV5 (Sampling Feedback Form)

Accepted?

No

‘Not Accepted’
applied on IV5 with
re-verification date and
circulate copies

Actions
agreed?

Yes
‘Accept’ applied on IV5
with feedback/comments

Yes

No

Actions Complete
Assessor, IV and CLM and where
appropriate, AP to discuss and
agree further actions

IV updates IV13

Assessor results
Candidates on Columbus

Actions
agreed?

Yes
MIS forwards results to
Awarding Body

No

AP consulted. A request for a
development visit may be made to
the Awarding Body if appropriate.
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Appendix 5

Criteria for a ‘Not Accepted’ decision
Assessment instrument(s) not available
The assessment instrument(s) and the assessment specification for Unit(s) were not
available for scrutiny by the external verifier.
Inappropriate assessment method(s)
The Method(s) of assessment selected did not assess the relevant outcome(s)
validly.
Incorrect or inappropriate assessment specifications
Either the assessment specification was not followed, or the range had not
been covered or the Evidence requirements defined in the Unit were not
correctly specified.
No evidence or insufficient evidence of Candidate performance
Sufficient Evidence of assessment of all Candidates for the relevant units was not
supplied.
Performance criteria not met
The Evidence of Candidate performance failed to reach the level of performance
defined in the performance criteria.
Inappropriate judgement of Candidate performance
The Assessors have incorrectly assessed the Evidence supplied to them by
Candidates and have judged Candidate competent when the standard specified in
the criterial has not been met.
No record of Candidate achievement
The centre has failed to keep records about the Candidate’s performance.
Internal Verification arrangements were not effective
The centre has failed to:
•
show that all assessment methods, designed for a particular Unit are
comparable in terms of demands made on Candidates
•
show that results are consistent between Assessors
•
show that results are consistent across Candidates
Any of the above could be considered criteria that may result in issues being
identified by the Awarding Body and could lead to ‘Sanctions’ being placed at varying
levels.
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Appendix 6

Standardisation Activities
Reliability is a measure of the accuracy and consistency of Assessors’ judgements.
Standardisation is an important part of ensuring the reliability of assessment
decisions for all Candidates.
Standardisation exercises identify any discrepancies between Assessors in their
judgement of Candidates’ evidence and allow adjustments to be made to remedy
these. This is particularly useful when several Assessors are delivering the same
unit. As well as reducing subjectivity among Assessors, it helps to improve the
consistency of their judgements and allows IVs to identify and disseminate good
practice.
There are different ways of carrying out standardisation, and the IV should make sure
that the method used is the most appropriate for the nature of the evidence.
The following examples are standardisation exercises that could be used and coordinated by the IV and CLM:
Agreement trials: Assessors work together to consider examples of Candidates’
work based on the assessment scheme. By discussing discrepancies and coming to
a shared understanding based on the assessment criteria, the Assessors reach a
common understanding. Involving the IV is very helpful in achieving consensus.
Dual assessment: Two Assessors assess the same Candidates. Teaming an
experienced Assessor with a new Assessor is not uncommon, but there are benefits
for any Assessor in checking their judgement, particularly for new qualifications and
awards. It also encourages co-operative working.
Cross assessment: Assessors exchange Candidate evidence to check each other’s
interpretation of the standard. This does not mean that different Assessors must
follow the same assessment procedure or even use the same assessment material.
Evidence reviews: In this process, the IV collates assessed Candidate evidence
and asks a group of Assessors to discuss any discrepancies between their
individual judgements. This allows professional development as well as ensuring a
shared understanding.
Double marking: Generally used with written evidence, double marking is a form of
cross-assessment in which Assessors exchange the same Candidate evidence to
check each other’s interpretation of the standard.
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Appendix 6

Blind marking: Again, mostly used with written evidence, blind marking, is intended
to reduce any bias, however unintentional, by an Assessor. In one form of blind
marking, evidence is marked by two Assessors, but each is unaware of the other’s
mark. Discrepancies between the marks can then be resolved. In another form,
evidence can be made anonymous by removing the Candidate’s details.
Standardisation exercises should take place throughout the assessment process to
improve the consistency of assessors’ judgements. Records of standardisation
exercises, including any feedback to Assessors, should be kept as evidence of
Internal Verification activity. These exercises can form part of the
Standardisation/Cognate Group meeting Agenda.
Procedures should also ensure that standardisation is carried out for centres
operating across multiple sites or with partnership arrangements.
Pearson provide exemplar material for BTECs as part of their annual online training
for Lead IVs. They strongly encourage the Lead IVs to use this material with the
Assessors to help achieve consistency of marking prior to any material being
assessed.
City & Guilds insists on Interim Sampling, stating it is the responsibility of the IV to
ensure accuracy and consistency of assessment by taking action before, during and
at the conclusion of learning delivery, to make sure that all learning delivered, and
assessment decisions taken are accurate and similar irrespective of who is involved.
City & Guilds requires all approved centre’s to ensure that regular sampling activities
are undertaken on all relevant qualifications
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Appendix 7

Useful Internal and External Documents
Available from the College Intranet:
•

Notification of Delivery Form (IV1)

•

IV Feedback Form for New or Amended Assessments (IV2)

•

Internal Verification Checklist (IV3)

•

Internal Verification Sampling Request Form (IV4)

•

Internal Verification Sampling Feedback Form (IV5)

•

Unit Deferral Request Form (IV9)

•

SCQF Annual Report from Internal Verifiers (IV10)

•

Internal Verification Audit Form (IV11)

•

Notification of Delivery Form/Completed Example (IV12)

•

IV Sampling Plan (IV13)

For VQ Delivery:
•

VQ Internal Verification Feedback Form (IV6)

•

VQ Final Verification Form (IV7)

•

Record of Assessor Monitoring (IV8)

Examples of useful external documents
The SQA framework is used as a model for all Internal Verification requirements.
However, where an Awarding Body has specific requirements (for example City &
Guilds and BTEC/Pearson) these must be followed using the guidance provided by
that Awarding Body.
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Appendix 8

Role of the Assessor:
1
2
3
4
5
6
7
8
9

Prior to assessment taking place, complete a Notification of Delivery Form (IV1)
and forward to the IV
Ensure that only the current assessment methods/instruments approved by the
Awarding Body and Verification Group are used
Record Candidate competence in accordance with agreed procedure
Ensure all assessment evidence and records are up-to-date and provide for
verification/audit purposes within the agreed timescale
Advise IV and CLM where issues arise that may cause delay in responding to
verification requests
Undertake and complete, within 18 months of taking up their post, the relevant
Professional Assessor Award
Undertake continuous professional development
Only assess units and awards up to the level below their own level of
qualification
Ensure that their CPD records are kept up-to-date and are made available to
external Awarding Bodies

Notes from Awarding Bodies:
BCS – Invigilators are observed at their first live test session and are thereafter
observed annually by a BCS registered member of staff to ensure test regulations
are being followed. An Invigilator Observation Report is signed on completion of the
observation.
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Appendix 8

Role of the Internal Verifier (IV):
1
2
3
4
5
6
7
8
9
10
11
12

Internally Verify all assessments against Awarding Body standards to ensure
the assessment meets the requirements of the Unit Specification
Authorise distribution of controlled assessment packs to the Assessors using
the Notification of Delivery Form (IV1) and store documentation on the shared
portfolio area
Internally Verify New or Amended Assessments (IV2)
Sample assessments in line with the Internal Verification Sampling Plan (IV13)
agreed by the CLM and update IV13
Advise CLM where issues arise that may cause delay in responding to
verification requests
Prepare materials for an EV visit in liaison with Lead IV and be available during
an EV visit if required
Maintain an electronic IV folder as identified in Appendix 4 of Internal and
External Verification Procedures
Ensure the IV assessment decisions are consistent and accurate
Undertake continuous professional development
Only verify units and awards up to the level below their own level of qualification
Ensure that their CPD records are kept up-to-date and are made available to
external Awarding Bodies
Assessments that have been developed by the IV must be internally verified by
another IV

Role of Lead Internal Verifier (Lead IV):
1
2
3
4

Monitor internal verification activity within their assigned area of responsibility
Maintain the Internal Verification Sampling Plan (IV13) as per the requirements
of the portfolio area.
Co-ordinate the assessment materials of all Assessors and IVs in preparation
for an External Verification visit
Contribute to Standardisation/Cognate Group meetings, a minimum of two per
academic year
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Role of Curriculum and Learning Manager (CLM):
1
2
3
4
5
6
7
8
9

Provide guidance and support to staff working within the verification groups and
monitor documentation to ensure effective and secure record keeping practice
is maintained
Ensure that sufficient occupationally competent IVs are available to support the
verification process
Chair Standardisation/Cognate Group meetings and hold a minimum of two
per year with Action Minutes circulated to all affected staff.
Oversee the course structure information on ProSolution and the management of the Internal
Verification Sampling Plan (IV13)
Monitor status of ‘Not Accepted’ decisions
Ensure that CPD for staff operating the Internal Verification system is carried
out and records are kept up-to-date and made available to External Awarding
Bodies when required
Co-ordinate requests from Awarding Bodies for Central Verification to ensure
that materials requested are collated by the Internal Verification team
Complete pre-External Verification planning and paperwork requested by the
QEC
Ensure any actions required following an EV visit or event are addressed
within the specified timescale

Role of Quality Assurance Co-Ordinator (QAC):
1
2
3
4
5
6
7
8
9
10
11
12
13

Act as centre contact for Awarding Bodies and all External Verifiers where
appropriate
Liaise with Awarding Body and CLMs to arrange appropriate dates for EV visits or events
Monitor verification reports
Seek and agree a plan of appropriate verification from external agencies if
requested by CLM
Report to the relevant AP matters relating to quality assurance
Ensure the list of IVs and Lead IVs is updated on an annual basis
Maintain records of external ‘Not Accepted’ results and monitor progress for the
return of materials to the Awarding Body to ensure that deadlines are met
Manage the Central Verification process along with the CLM to ensure materials
requested by the Awarding Body are submitted as required
Oversee control of SQA secure website for assessments
Collate feedback from CLM with regards any discrepancies in assessment
material and forward to Awarding Bodies
Disseminate information to relevant staff from Awarding Bodies
Forward feedback from External Verification visits or events to the AP and the
CLM and provide updates on External Verification activity to the Senior
Leadership Team
Record EV feedback and monitor the EV spreadsheet detailing
recommendations and actions
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Role of Assistant Principal (AP):
1
2
3

Overall responsibility for the IV process across each portfolio area in line with
the College’s Internal and External Verification Policy and Procedure
Ensure that all procedures are monitored and reviewed regularly to reflect the
needs of students
Report to appropriate representatives of management on issues relating to
quality assurance

Role of Assistant Principal Quality and Development:
1

Ensure that procedures fundamental to the College's Internal and External
Quality Policy and Procedures are always implemented
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Appendix 9

IV SECURITY PROCESS
1.

Introduction

The IV security process is necessary to ensure that a clear, transparent process is
available for all staff to follow, that protects and demonstrates the integrity of our
Internal Verification methods.
Whilst Internal Verifiers at the College have previously used an electronic stamp, this
is no longer necessary. It will be sufficient to record Key Details on the assessment
instrument, provided the additional security steps outlined in this process are taken to
protect the document.
2.

Assessment Instruments – NOT pre-verified:

Key Details in document footer:
Assessment approved by Internal Verifier: [IV name]
Date: [Date document is IV’d]
Expiry: 2 years or until unit change (whichever is
soonest)

This works across the
curriculum areas, prevents
documents from sitting for
too long without being
checked, and allows for unit
changes within the 2 years.

2.1 Assessment Instruments – designed for printing as a paper copy, for
students to complete by hand:
Assessor:
•
Creates assessment instrument in Word
•
Send the assessment instrument to the IV for Internal Verification
Internal Verifier:
•
Receives assessment instrument as a Word document
•
Internally verifies the assessment instrument adding Key Details in the footer
2.2 Assessment Instruments – designed for online use for student to type
into:
Assessor:
•
Creates assessment instrument in Word
•
Uses Developer mode to create tick boxes, text boxes, drop-down options, etc.
•
Sends the assessment instrument to the IV for Internal Verification
Internal Verifier:
•
Receives assessment instrument as a Word document
•
Internally verifies the assessment instrument adding Key Details in the footer
•
Adds Restrictions on Editing (editing for forms only) with password protection
•
Saves protected Word copy in relevant secure area for use by the Assessor
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Using Forms in Word
Enable the Developer tab to create tick boxes, text boxes, drop-down options etc:
1.
2.

Create document
Enable the developer tab
a.
On the File tab, choose the Options button
b. In the Options dialog box, choose the Customize Ribbon button
c.
In the list of main tabs, select the Developer check box
d. Choose the OK button to close the Options dialog box

NOTE: Once you have enabled the Developer tab in Word, you should not have to
do it again

Use the Developer tab to create tick boxes, text boxes, drop-down options etc:
1.

In the Developer tab use the options in the ‘Controls’ area to add areas
throughout the document where you would like to allow users to edit
a.
– This icon allows you to add text areas in the document
b.

– This icon allows you to use checkboxes

c.

– This icon allows you to insert drop down menu items

You can choose which options are possible by clicking the drop-down entry and then
clicking the ‘Properties’ button in the developer tab:
Click ‘Add’, enter your option in ‘Display name’, click ‘OK’
Repeat for all your options
Tick ‘Contents cannot be edited’, click ‘OK’

Use the Developer tab to add Restrictions on Editing, with password protection:
1.
2.
3.
4.
5.
6.

Open the document
In the Developer tab choose ‘Restrict Editing’
Tick the box for ‘Editing restrictions’
In the drop-down, choose ‘Filling in forms’
Click ‘Yes, Start Enforcing Protection’
Enter a password for the document (and repeat) then click ‘OK’

NOTE: Keep your password in a safe place and do not share it
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Appendix 9

Assessment Instruments – PRE-VERIFIED:

In cases where the Awarding Body has pre-verified assessment instruments, it is
important that these are accurate for the students. It is the Internal Verifier’s
responsibility to check all assessments including SQA or other Awarding Body
material (ASPs, NABs, Exemplars, E-Assessments, etc.).
3.1 Where the IV is satisfied that the pre-verified assessment instrument is
correct and the IV has recorded on the IV13 that the assessment has
been checked:
•

It needs an additional footer or stamp and may be saved in the relevant secure
area for use, following the filename conventions indicated in No 5 below

3.2 Where the IV finds that the pre-verified assessment instrument is
inaccurate:
•
•
•

Inaccuracies and changes to be made to the assessment instrument must be
discussed and recorded in the Minutes of Standardisation/Cognate Group
meetings
Advice must be provided to the Awarding Body (correction sheet) on the
inaccuracies and the changes made
The corrected assessment instrument must be internally verified as described
above for non pre-verified assessment instruments, depending on the type of
document, and placed in the relevant secure folder

3.3 Where inaccuracies become known after the Notification of Delivery form
has been issued:
•

The Assessor must request that the assessment instrument is internally verified
again

4.

Storage of Internally Verified documents

Curriculum and Learning Managers will:
•
•

•
•

Use a consistent approach with their teams
Create new Internal Verification folders for internally verified documents each
academic session:
•
organised by the needs of the teaching area
•
to enable current assessments and related documentation to be easily
located
Emphasise with teams that these are the only approved assessment
instruments
Determine their approach to prioritise assessment instruments to be internally
verified over a finite period, to ensure all assessments are brought up to date

NOTE: use of unapproved assessments is a breach of the College’s Malpractice
Policy and falls short of professional standards.
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5.

Filename Conventions

In order to identify those assessments have been internally verified, all
assessment should be saved and include the following information:
BC 7-23
e.g. F8LE_35_AEX001_Aug_18 BC 7-23
This identifies that the assessment exemplar for the unit F8LE 35, fourth edition
dated August 2018, has been internally verified at Borders College with an expiry
date of July 2023

Status:
Policy Dated:
Author:
Review Date:
Equality Impact Assessed:

Noted by JCC
March 2021
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